UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS

EXERCISE 8 —= TUTORIAL

Mapping wildfires and burn severity using Sentinel-2
data, using SNAP software
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1 | Exercise outline

In this exercise,we will:
e Detect wildfires on Sentinel-2 image
e Export subset as image to perform another analysis in QGIS

e Map burned areas and quantify burn severity using Normalised
Burn Ratio index

e Develop a graph for automated processing using Batch processing
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2 | Background

Fires in the grasslands
close to a vital South
American river delta
present serious threats
to both nearby wetland
ecosystems and human
well-being, caution
environmental experts.

The wildfires around the important riverside port of Rosario, essential for
transporting Argentina's extensive grain harvest, have raised concerns
among local residents and activists.

Fires in the grasslands close to a vital South American river delta present
serious threats to both nearby wetland ecosystems and human well-
being, caution environmental experts. The wildfires around the important
riverside port of Rosario, essential for transporting Argentina's extensive
grain harvest, have raised concerns among local residents and activists.

The Parana River, South America's second-longest river after the
Amazon, experienced its lowest water levels since 1944 in 2021 as
reported by official data. This decline is attributed to multiple cycles of
drought and reduced rainfall in upstream Brazil. In August 2022, the
water level remained exceptionally low. The wildfires, many intentionally
set by farmers preparing the land for new crops, generated a thick haze
that reached Buenos Aires, located approximately 190 miles (300 km)
south of Rosario. Residents were displeased with the presence of soot in
the air, leading popular weather apps to issue forecasts simply describing
the conditions as "smoke."

Wildfires burning in the wetlands of the Parana River Delta, Argentina,
19 August, 2022
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2.1 Study area and data used

For this exercise, we will use two Sentinel-2 images of the same area in
Parana River Delta, Argentina, using the Tile Number *20HQJ*
downloaded for two days of summer 2022 (before and after the wildfires)
from the Dataspace Copernicus Open Access Hub
[@https://dataspace.copernicus.eu/].

2.2. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and open 2 downloaded products
(unzipped) by double click on the metadata ,MTD_MSIL2A.xmI" inside
the folder. The opened products will appear in Product Explorer window.

S2A_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856.SAFE.zip
S2A_MSIL2A_20220819T135721_N0400_R067_T20HQJ_20220819T211159.SAFE.zip

A: Detecting wildfires on Sentinel-2 image
1. Select the first product in the Product Explorer window.
2. Right click on the product.
3. Open RGB Image Window.
4. In the pop-up window select ‘Sentinel 2 MSI Natural colors (Red: B4;
Green: B3; Blue: B2).
Produc‘lEprorerX|PierInfo | = ESeIectRGB-ImageChannels x|
w5 [1] 52A_MSIL2A_20220730T135711_N040D_R067_T20HQJ_20220730T210856 E
- [2] 52A_MSIL2A_20220819T135721_N0400_R067_T20HQ]_20220819T211159 Profile: =
Eentingl 7 1 Fatiiral Colors &3 8 im [ 2
Navigation - [1]...| Colour Manipu... | Uncertainty Vi... |World View X | — =
Red: |B4 [ foen =<
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Green: B3 e -g
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Blue: |B2 | e ﬁ
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Off Globe B s ;.
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5. Repeat the process for the second product.
6. Tile two opened RGB Windows, e.g. horizontally

7. In the Navigation window, zoom in to the wildfire region and
syhnchronise views to see the same area before and after wildfires

v o

Product Explorer X | Pixel Info ‘ o
#-81 [1] S2A_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856
@81 [2] S2A_MSIL2A_20220819T135721_N0400_R067_T20HQJ_20220819T211159 |

|World View |
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Do the same process for obtaining the color compositionin false colors:
1. Select the first product in the Product Explorer window.

Right click on the product.

Open RGB Image Window.

In the pop-up window select ‘Sentinel 2 MSI Atmospheric penetration
(Red: B12; Green: B11; Blue: B8A).

Apply color manipulation (stretching) for RGB
Repeat the process for the second product.
Tile opened RGB Windows, e.g. evenly

If necessary, in the Navigation window, zoom in again to the wildfire
region and syhnchronise views to see area before and after wildfires
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Product Explorer X | Pixellnfo | — | [ [1] Sentinel 2 MSI Atmosp... ¥ O [ [1] Sentinel 2 MSI Natur
@8 [1] 52_MSIL2A_20220730T135711_NO400_R067_T20HQJ_20220730T210856 | [ A4y = WiEy, :
@5 [2] S2A_MSIL2A_20220819T135721_N0400_R067_T20HQ]_20220819T211159
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Now let’s detect the smoke plume:
1. Keep only the Sentinel 2 MSI Atmospheric penetration composition
with visible smoke plume from 19 August open

2. Go to Mask Manager, and scroll down to the Maths masks
3. Select: “scl_cloud_medium_prob" and “scl_cloud_high_proba"
4. To visualize the masked areas better, lower the transparency(e.g. 0.1)

[ [2] sentinel 2 MST Atmospheric penetration RGE X ||: Mask Manager X & |Gy
b R N & ‘S‘-‘ T AR S L -
'3_\ i 3 ’} | | 62| Name Type  Co.. Tra... Description f(x) [x] 2
| ESEaal ! l— c
B ; N 5
[ |saturated_|1a_B12 Maths 0.5quality mask - Saturated pixels L1A -B12 ™ E‘% =
g
- | 1 [sd_nodata Maths 0.5/Mo data o
o -
! |:| scl_saturated_defective  |Maths 0.5/3aturated or defective
4 | [] |scl_topographic_and_ca...[Maths |[Jll| 0.5 topographic and casted shadows =
[ |sd_deoud_shadow Maths - 0.5|Cloud shadow -
|| [ |sd_vegetation Maths |:| 0.5|Vegetation &
=
; [ |sd_not_vegetated Maths I:I 0.5|Not vegetated %
O |sd_water Maths I:I 0.5(Water 5
o | [T |sd_undassified Maths I:I 0.5|Undlassified
i scl_cloud_medium_proba  |Maths 0.1|Cloud (medium probability) =
: sc_coud_high_proba Maths 0.1|Cloud (high probability) =z
i [ |sd_thin_dirrus Maths 0.5(Thin cirrus "%‘
- [ |sd_snow_ice Maths 0.5/Snow or Ice W %
< > @ |3
-Y - Lat - Llon - Zoom — Level — Pixel Spacing: —m —m E_-Q 3

Fire + cloud plume map
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Let's export this View as an ima

Because of multiple S2 spatial sizes, we first have to resample the data.

Resample to highest spatial resolut

ge and safe as a GeoTIFF:

ion: 10 m (e.g. B2).

NOTE 1: The input product
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Raster->Geometric->Resampling:
+ Keep I/O names

« In Resampling Parameters, select B2 (10 m)

E Resampling
File Help

Resampling Parameters

Source Product

MName:
[1] 52A_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856 -

Target Product
Name:
S2A_MSIL2A_20220730T135711_N0400_R067_T20HQI_20220730T210856_resampled
[] save as: | BEAM-DIMAP
Directory:

C:\Users\Onacdilova

Open in SNAP
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X ﬂResampling
File Help

If0 Parameters Resampling Parameters

Define size of resampled product

(®) By reference band from source product: |82

Resulting target width: 10980
Resulting target height: 10980

Resulting target width: 54390

Resulting target height: 5430

Define resampling algorithm

Upsampling method: Mearest
Downsampling method: First
Flag downsampling method: First

[[] Advanced Method Definition by Band

Resample on pyramid levels (for faster imaging)

() By target width and height: Target width: 10,980 =
Target height: 10,980 5
Width [ height ratio: 1.00000

() By pixel resolution (in m): 205
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Let’'s create a subset based on the current view

- Display the image. Note that now many more color options are
available. Select MSI Atmospheric penetration

¥ select RGB-Image Channels X | select RGB-Image Channels *

Profile: Profile:

Sentinel 2 MSI Matural Colors ?Senﬁnel 2 MSI Atmospheric penetration

Sentinel 2 MSI Natural Colors A

Sentinel 2 MSI False-color Infrared | e Red: | B12 v

Sentinel 2 MSI False-color Urban )

Sentinel 2 MSI Agriculture R [] fixed range REY R

Sentinel 2 MSI Atmospheric penetration

Sentinel 2 MST Healthy Vegetation bl ) £ Green: |B11 >

Sentinel 2 MSI Land/Water i [] fixed range = i

Sentinel 2 MSI Natural with Atmospherical Removal W 9

Blue: B2 W[ e Blue: |BBA w

Xed range min max Xed range min max

[ fixed rang i [ fixed rang i

[ store RGE channels as virtual bands in current product [ store RGE channels as virtual bands in current product

Cancel Help Cancel Help

+ Make a zoom and add the cloud masks again

B snap - [m] X
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help 1)
= ] " \ i 7 i > B GCP g 222 v iyiviy
S DE S dPIQ/rUOBEY CBELSBITEE O iviviy
Product Explo... X}Pixellnfo ‘ = !EMask Manager X & 15
-5 [1] S2A_MSIL2A_20220730T135711 ol
o b n il || @ N T Co... Tra... D ti x) [X. o
6-68) [2] S2A_MSIL2A_20220819T135721 - ype . o... Tra escription f(x) [x] g
-6 [3] S2A_MSIL2A_20220819T 135721, | [ |dirrus_dlouds Maths |[:! 0.5|quality dassification - Cirrus A & o
2 5 ‘> i [] isnow_and_ice_areas Maths l|:| 0.5|quality classification - Snow D = E,-
: & | (] |sd_nodata Maths [l 0.5MNodata d =
| [] |sd_saturated_defective [Maths !- 0.5|Saturated or defective L =] = | =
; Q = | [] |sd_topographic_and_ca...Maths |[Jllll  ©0.5|topographic and casted sha B i
< L o
2 Q [ |sd_cloud_shadow Maths (- 0.5|Cloud shadow 3
i | 9 | " =
: Q ; [ |sdl_vegetation Maths !- 0.5|Vegetation §
- [] |sd_not_vegetated Maths [:] 0.5|Not vegetated ]
o || [ |sd_water Maths |-‘ 0.5Water
[ |sd_undlassified Maths [- 0.5|Undassified =
% % sd_cloud_medium_proba |Maths 0.1|Cloud (medium probability) =|
. % E sd_cloud_high_proba Maths 0.1(Cloud (high probability) 3',; [
2 . IRV T [ |sd_thin_cirrus Maths 0.5([Thin cirrus 9 g
1:217.84 | | e H@ | > = (DK
X -—-Y - Lat - Lon - Zoom - Level - Pixel Spacing: —m —m \:g 3

+ Right-mouse button -> Spatial Subset from View - in the Band Subset
you can select all or only few bands to be exported

[ [5] Current Profie R X | | B specify Product Subset X [ Specify Product Subset X
¥
3
% Spatial Subset  Band Subset Tie-Point Grid Subset Metadata Subset Spatial Subset Band Subset  Tie-Point Grid Subset  Metadata Subset
3
ct [ 81 Reflect band B1 2
= ¢ Bixel Coordinates’ Geo Coordinates L sflectancs in bam
FAo it o2 reftectance in band B2
ooy oW s Scene start X: 4,397[%
= | B2 ‘Reflectance in band B3
3 Scene start ¥: 3,405
& B4 Reflectance in band B4
g Scene end X: 10,9795
2 = B5 Reflectance in band B5
Export View as Google Earth KMZ 2 Scene end Y: 10,3374
e : B8 Reflectance in band BE
port View as Image =
Export Colour Palette as File B : = = FEERETIE I 2 v
Scene step Y: 1 < >
Spatial Subset from View... . g::::: :E::s :i?m: ::g;‘g Selectal [ Selectnone
Copy Pixel-Info to Clipboard i
= -
¢ Estimated, raw storage size: 11395.5M Estimated, raw storage size: 11395,5M
Cancel Help Cancel Help
- Level — Pixel Spacing: —-m —-m @
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Let’s reproject the image in Latitude & Longitude coordinates
* Raster->Geometric Operations->Reprojection

+ Select the default: Geographic Lat/lon (WGS 84)

* Run (writing might take some time)

E Reprojection x E Reprojection *
File Help File Help
1/0 Parameters  Reprojection Parameters 1/0 Parameters
ST Coordinate Reference System (CRS)
Name: (@) Custom CRS
[4] subset_D_of 524 _MSIL2A_20220819T135721_N0400_R067_T20HQ]_20220819T211159_resampled
Geodetic datum: |World Geodetic System 1984
o Projection: Geographic Lat/Lon (WGS 84) v
Name: Projection Parameters...
subset_0_of_S24_MSIL2A_20220819T135721_N0400_RO67_T20HQJ_20220815T211159_resampled_reprojected
() Predefined CRS Select...
Save as: BEAMDIMAP v — — - -
() Use CRS of [1] 524_MSIL2A_20220730T135711 NO400_R067_T20HQ]_20220730T210856
Directory:
Z:\FSA_ENEUM'exercise_8| - Output Settings
Openin SNAP Preserve resolution Reproject tie-point grids
Output Parameters. .. No-data value: MaM
[] Add delta latflon bands Resampling method: | Nearest w
CQutput Information
Scene width: 7846 pixel Center longitude:  60°01'58" W
Scene height: 6929 pixel Center latitude: 33%0720°S
CRS: WGS84(DD) Show WKT
o R ] [

Now we can export View as GeoTiff
« Right mouse button: Export View as Image
« Select: Full scene, Full resolution, GeoTIFF

B SNAP - Export Image X
& [3] Sentinel 2 MSI Atmospheric penetraton RGB X -
Save in: exercise_§ v ¥ Ea-
s, : “y Image Region
[ Nazov .. Typ pologky
= 524 MSIL2A_20220819T135721_NO4OO ROS7...  Priedinok si..| = "o 890
Naposledy p... S24_MSIL2A_20220730T135711_NO400_RD67... Priefinok sii...| (@) Ful scene
. Image Resalution
Pracovnd plo... Wiew resolution
= (@) Full resolution
= (C) User resolution
Dokumenty <
& File name: 524_MSIL24_20220819T135721_T20HQJ_RG. tif
Tento poditac F1eS Of tYPe! | GeoTIFF - TIFF with geo-location (*.4f, *.tiff) > Cancel

Export Mask Pixels
Export View as Google Earth KMZ
Export View as Image

Export Colour Palette as File

g

. |
& . . ’)’
Py Spatial Subzet from View... N
Copy Pixel-Info to Cllpl::n:uard I;\-

= - e
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Now we open the output image in QGIS

« We can overlay it to e.g. Google Satellite or Bing aerial image:
+ Web->OpenlLayers plugin->Google Maps->Google Satellite

* Move the Subset above the satellite

« Play with Transparency: Properties->Transparency (e.g. 80%)

(2 *Untitled Project — QGIS - m} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh HCMGIS SCP Processing Help

DEERRY UL RI PPRAS~NEaLNOZ @ ¥ == 0-m-
B@Vo 28 ' " - @R a0
-5 2 ~Band:| 1 ~ | |0 ,’/9.‘!81\, d&ﬁ = E;]» »

Processing Toolbox ®
‘a' &0 E N

Layers (SE3)
¥ @ ® TV -0

== subset 0 of S2A MSIL2A 202208
V' Bing Aerial

- Recently used
(@ Cartography
(Q Database

Q@ Filetools

(@ Interpolation
(@ Layertools

Q@ Mesh

) Network analysis
Q Plots

(2 Raster analysis
( Raster creation
@ Raster terrain analysis
@ Raster tools

@ Vector analysis
@ Vector creation
(@) Vector general
(Q Vector geometry
@ Vector overlay
(@ Vector selection
() Vector table

@ Vector tiles

& GDAL

& GRASS

& saca

4 Type to locate (Ctrl+K Coordinate | -6738211,-3891200 % Scale | 1:669514 | ~ 8 Magnifier | 100% ~| Rotation |0,0° %) |VIRender #EPSG:32720 Q
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B: Burned area mapping with Sentinel-2
How to quantify the impact of the Parana wildfire?

Let’'s have look to the before & after images:
e Open RGB Image Window:

e Select: MSI Atmospheric penetration

e Window-> Tile horizontally, zoom in

B2 (1] Sentinel 2 MSI Atmospheric penetration RGB - S2A_MSIL2A_20220730T135711_N0400_R067_T20HQ)_20220730T210836 - Z:\Projekty\2023...  — m} X
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help |Q~ Search (Ctrl+1)

. : = - 73 & v viviviviy
AR HDE LS JPILR [ AA MO BRI Y TBESY ivivivivie

Product Explo... X ‘ Pixel Info ‘ — ﬂ [1] Sentinel 2 MSI Atmospheric penetration R... i 1 Atmospheric penetration R.
@5 [1] S2A_MSIL2A_202207307135711 || M T s.;’?i' A st | ISR g
@& [2] S2A_MSIL2A_20220819T135721 | | &

Aleiqr pnpoid |

X ICoIo... ‘Unce...‘Worl... |

J1abeuely jsel iy

® vELAAL |,

X -y - ‘ Lat - Lon - Zoom - Level — Pixel Spacing: -m —m @

Let's create a cloud mask:

e Go to Mask Manager, and scroll down to the Maths masks

e Select: cloud medium & cloud high probability & Thin cirrus
e To visualize them better, lower the transparency (e.g. 0.1)

[ [1] sentinel 2 MSI Atmospheric penetration R... [ Mask Manager X 127
. 4 3 e o i fg"- prel el
%@ fie 'l , A | @ | Name ... Colour Tra... Description fx) [x] | g
A G ) = . - - - - 8 | 5
v p 5 2 A % | [ |sd_nodata . 0.5Nodata E}& =
: % e [] |sd_saturated_defective 0.5|Saturated or defective Lm I ] E
# | [ |sd_topographic_and_... ... Ml/ldl  ©-5/topographic and casted sh B ‘,;'
[] |sd_cloud_shadow - 0.5|Cloud shadow @ =
| [ |sd_vegetation _ 0.5|Vegetation & z
1| | [ |sd_not_vegetated 0.5/Not vegetated z
3 W :
[ [sd_water 0.5|Water e e | 3
| [ |sdl_undassified 0.5|Undlassified :;@: % 'r.j
: sc_cloud_medium_proba|... 0.1|Cloud (medium probability) % ﬁ
scl_cloud_high_proba  |... 0.1(Cloud (high probability) @\«.
isd_thin_cirrus 0.1/Thin cirrus
1 | [ [sd_snow_ice 0.5/Snow or Ice v
B S %)
sy { S 3 5 & i
X o=y — Lat —lon - Zoom - Level - Pixel Spacing: —m —m 2

Now we make a cloud band based on the selected mask
e Band math expression
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We make a cloud band based on the selected mask
« Navigate to Raster - Band Maths
« Name the new mask: clouds

B Band Maths b4 | £ New Logical Band Maths Expression x
Target product: Data sources: Expression:
[1] 52A_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856 ~ scl_cloud_shadow & @and @ scl_cloud_medium_proba or
— douds| scl_vegetation aoa scl_cloud_high_proba or scl_thin_cirrus
pa— scl_not_vegetated
escripuon:
) scl_water T
Lo scl_unclassified (@)
Spectral wavelength:| 0.0 scl_cloud_medium_proba Constants... e
Virtual {save expression only, don't store data) scl_cloud_high_proba Operators. .. e
Replace MaM and infinity results by NaN SE T S v Functions... ~
Show bands
[[] Generate assodiated uncertainty band
] Show masks
Band maths expression:
Show tie-point grids

OK Cancel Help - -

Load... Save... Edit Expression... Show single flags

Adding the cloud mask as a band

e On the image, right click-> Band Maths

e Make sure to deactivate “Virtual”. We want to store the data!
e Go to “Edit Expression”

e Select Clouds

Repeat for the second image

{3 Band Maths > E Band Maths Expression Editor X
TR Product: | [2] 52B_MSIL2A_20220824T135709_N0400_R067_T20HQI_20220824T 195004 -
[2] 52B_MSIL2A_20220824T135709_N0400_R067_T20HQ]_20220824T 195004 - -

Data sources: Expression:
Ban= cloud_mask 52.=cl_not_vegetated - @+@ $2.CIOudS|
Description: $2.scl_water

= @-@
Unit: £2.=cl_unclassified
*

Spectral wavelength:|0.0 52.scl_cloud_medium_proba a‘a

[ ¥irtual {save expression only, don't store data} 32scciudohrcoh e

L 52.scl_thin_cirrus (@)
Replace NaN and infinit MaM

52 =cl_snow_ice
. . Constants... ~
Generate associated uncertainty band 22 clouds

Show bands
Show masks
Show tie-point grids

Band maths expression: Operators... b

Functions... ~

Load... Save... Edit Expression. ..

@ 0Ok, no errors,
Cancel Help Cancel Help

Show single flags
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Vizualize all products
+ Windows: Tile evenly
* Navigation: zoom all

E [2] Sentinel 2 MSI Atmospheric penetration RGB - S2A_MSIL2A_20220819T135721_N0400_R067_T20H... — O X
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q- Search (Ctrl+
ain A diPw i oA A @ [ v ivivivivivig
| Product Explo... X |Pixelinfo | — | [ [1] Sentinel 2MSIAtmo... ¥ O [ [1] doud_mask x| ¢ voO

. . el Ao R R e : : -

-

— ~————
+-= [1] S2A_MSIL2A_20220730T135711 .

1abeuely 124e LL[] h

Ateaqr pnpod A0

1abeuely ysel Iy

Lon - Zoom - Level -

Tools - Graph Builder
B Graph Builder *
File Graphs

| Read HMsampleH Subset BandMerse|>-—)| Write |

° Add_>RaSter_>Ge0metr|C_>Resample ESNAP-SaveGraph W

. Savein: exercise_9 w & ER-
+ Add->Raster->Geometric->Subset

et Nazov Velkost' ... Datum dprav
- Add->Raster->BandMaths = e
MNaposledy p... < >
+ Add->Raster->BandMerge B e
® Sa ve y0 ur cre ated g ra p h Pracovnd plo...  Files of type: Graph (=ml) Cancel
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Tools — Batch processing

This allows to process both images at the same time.
- Click on Add opened

- Load your graph

- Make sure to refresh

E [2] Sentinel 2 MSI Atmospheric penetration RGB - S2A_MSIL2A_20220819T135721_N0400_R067_T20H... — m} X
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q-
aB HE L b JPIRLR [ Aer @By ivivivieivi

37Product Explo... X | Pixel Info [ | @ [1] Sentinel 2 MSI Atm S W D ;@ [1] doud_mask
| @& [1] S2A_MSIL2A_20220730T135711 | .
| @& [2] S2A_MSIL2A_20220819T135721 |

J1abeuely 12ie [m h

"
o
3
o
5
=
o
b ) [E [2) sentinel 2 MSI Atmo... ¥ O [ [2] doud_mask x| b=
< | g RN . vIT ]

X | Colo... ;Unce... Worl...

J1abeueyy) yjsep)

Lon - Zoom - Level — Pixel Spacing: —m —-m Eg
2l Batch Processing x
File Graphs
S2A_MSILZ2A_20220730T135... -

S2A_MSIL2A_20220819T135... 19

e A | ype Acquisition Track Orbit ':|I]:'
S2A_MSIL2A_20220730T13... |S2_MSI_Level-24|30Jul2022 99999 99599 ?]:
S2B_MSIL2A_20220824T135...[52_MSI_Level-2A |24Aug2022 99999 99399

[=—1
|
55
%
s
2 Products

Target Folder

Save as: BEAM-DIMAP £

Directory:

Ci\Wsers\Onadillova\Desktop\ESA_ENEUM\exercise &
[] skip existing target files Keep source product name
Run remote Load Graph Run Close Help
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Resample
e Select a reference band: B2 at 10 m.
e Resampling method: Bilinear

a Batch Processing : myGraph.xml x
File Graphs
IjO Parameters Resample  Subset BandMaths BandMerge
Define size of resampled product “
B2 v
(@) By reference band from source product: Resulting target width: 10980
Resulting target height: 10980
Target width: 10,980 =
() By target width and height: Target height: 10,980 5
Width [ height ratio: 1.00000
100 5
(T By pixel resolution {in m): Resulting target width: 1098
Resulting target height: 1098
Define resampling algorithm
Upsampling method v
Downsampling method First v
Flag downsampling method First w v
Run remote Load Graph Cloze Help
Subset
e Select bands: B3, B8, B12, Cloud_mask
e Select Geographic coordination
e Click on A, zoomin to the area of interest
e Select a yellow box within the red square
i34 Batch Processing : myGraph.xml X

File Graphs

1/O Parameters Resample Subset BandMaths BandMerge

Source Bands:

Copy Metadata

() Pixel Coordinates  (®) Geographic Coordinates
Reference band: B1

Run remote Load Graph Run Close Help
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Ba nd Math &0 EXPLOITING SPECTRAL RESPONSE CURVES
e Go to “Edit EXpI’GSSiOﬂ” i S BUANED
e NBR: Normalized Burn Ratio: '

=
(B8-B12)/(B8+B12) =
=} \Y/ \,  HEALTHY
B - VEGETATION
File Graphs ELECTROMAGNETIC SPECTRUM (Wavekage jm)
S ———  —— —
045 @ 088 07 050 208 235
I/OParameters Resample Subset BandMaths  BandMerge VISIBLE NEAR INFRARED DiE) SHORTIAVE IFRARED (VIR0
Target Band: MBR.
Target Band Type: |float32
Band Unit: 8 Arithmetic Expression Editor *
No-Data Val
oA ) S Data sources: Expression:
Erpression- iy [ ~ a+@ {BE- B12)/(B8+ B12) ~
B8
@-@
B12
cloud_mask2 hd a‘a
Show bands @/@
Show masks (@)
v
Show tie-point grids | Constants... o — ; .
Show single flags Operators... w :fm_: @ TyanEnTE
Cancel Help

Edit Expression. ..
Run remote Load Graph Close Help

Band merge
e Keep the source bands: NBR, B3, B8, B12, cloud_mask

E Batch Processing : myGraph.xml pd

File Graphs

1/O Parameters Resample Subset BandMaths BandMerge

Source Bands: [NBR::Subset_S2A_MSIL2A_20220730T135711_NO400_R067_T20HQI_20220730T210856_resam...
B3::Subset 524 _MSILZA_20220730T135711 N0400_RO67 T20HQ]_20220730T210856_resampled
BS::5ubset_S24_MSILZA_20220730T135711 N0400_RO67 T20HQ]_20220730T210856_resampled
B1Z:5ubset 524 MSIL2A_Z0220730T135711 NO400_RO67 T20HDI_20220730T210855_resam...
doud_maskZ::Subset_S2A_MSIL2A_20220730T135711_NO400_R0OS7_T20HQI_20220730T21085...

Run remote Load Graph Close Help
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Running and visualizing the NBR band

Try a color table:

e Colour manipulation: Open color table, choose a color gradient, e.g.
»~derived from meris_cloud"

File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help {Q‘ Search (Ctrl+]) l

A BE LY dPaQ /A l@®nwl# X TRBELSBiv iviviviy

Produc... X |Pixellnfo | — || &
T TR vo©TmuTiy |
[ B12(2190.0 nm) %
i@ doud_mask 3
] Ner2 v 5
3
L
x| col... | [ [ - 2
25
o
S
o
5
=
o
s
<
B =
=
X —-Y - lLat -—-lon - | Zoom — Level — Pixel Spacing: —m —m @
2! (5] NBR - subset_3_of_S2A_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856_resampled - not saved - SNAP = [m} X
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help [Q~ search (ctrl+]) ‘
= = A r o= @ ; GeP ] v viviy
EF DE TUJPIQ A LUOR T GBELSBTEE Ny (viviy
Product Explorer X | PixelInfo | — |[E e x| ~ O @ 6lner2 x| &
[ 83 (560.0nm) ~ | [ 4o 5o IR o % | =
- 88 (842.0nm) WW AR X 5
[ B12(2190.0 nm) J o 2
i@ doud_mask ¥ g
[} NBR2 v A §
Navigation...| Colour... X | Uncertaint...| World View |
Editor: @) Basic () Sliders () Table @ 2 ;
s
o
Scheme Logyq 5
{ ==
- none - v Iﬁ' g
<
£
Palette
derived from meris_doud I 2| =
== 25 ‘%‘ ., =z
[[] Load exact values Reverse ke 4 S o & PR u §
% e DT g
Range A » g S v 8 % []
Min: -0.476927¢ Max: 0.5346223 v R S s R N e £ e e R A A A AL ey %
X =Y - [ Lat -—-Llon - Zoom -- Level - Pixel Spacing: —m —-m @
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You can also set the position of sliders and color them for better
visualization or change ranges of values in the Table tab.

NBR ranges between -1 and 1. A high NBR value indicates healthy
vegetation. A low value indicates bare ground and recently burnt
areas. Non-burnt areas usually have values close to zero.

B snap — ] X
file Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q- Search (Ctri+])
SR DESUIPIR AP UWOO T BB ALTOEE by vivs
Product Explorer X ‘ Pixel Info = ﬁ [(INBR X| Bl JOL = X‘ _ NG 8 it 8 &
[ B3 (560.0 nm) A | (g e T 7 1) ;’mg =
| £ i X
[ B8 (842.0 nm) o | Healthy 'LJ &2‘5
[ B12(2190.0 nm) iRsfee K
i E doud_mask T g Vegetatlon e R *‘ §
[ ner2 v | = - B
v!‘a"g,aﬁo"'"l,Co,'°,“":', X lUr)cVerta?nrt.V.._World View =il | '. |
Editor: () Basic (@) Sliders () Table by L \“ ;'
| 1o
Name: NBR > | g
Unit: Bt
Min: -6.333 : N . i | =
Max: 1.714 S | <
L Recently AN
' bumed S
areas E
a
£ 3 | 5
o b g
Zoom - Level — Pixel Spacing: —m —-m @

Burn severity - dNBR

The difference between the pre-fire and post-fire NBR obtained from the
images is used to calculate the delta NBR (dNBR or ANBR), which then can
be used to estimate the burn severity. A higher value of dNBR indicates
more severe damage, while areas with negative dNBR values may indicate
regrowth following a fire. The formula used to calculate dNBR is illustrated
below:

dNBR or ANBR = PrefireNBR - PostfireNBR

Go to Raster - Band Maths and Edit Expression

E 1 E Band Maths Expression Editor X
Ml
Target product: Product: {57 subset 3 of 534 Mall 28 202207301 136711 MO400 067 TI0HO, S02207 3rss §
[5] subset_3_of S2A_MSIL2A_20220730T135711 NO400_... || pats sources: o
MName: dMBR. [ $5.B3 R+@ $5.NBR- $6.MBR2
Description: s5.B8 @-@
it 55812
nit: .
25.cloud_mask e'e
Spectral wavelength: 0.0 il [s5.nBR aa
Virtual (save expression only, don't store data) @)
Replace NaM and infinity results by Mah Constants... ~
[[] Generate associated uncertainty band Show bands Operators. . i
Band maths expression: _ Functions... il
Show masks

$5.MEBR-- 56.NBR2

[ show tie-peint grids
Load... Save... | Edit Expression... |

Cancel Help

:ﬁ : Ok, no errars,

Cancel Help

Show single flags
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Set the position of sliders and color them for better visualization or change
ranges of values in the Table tab.

NBR ranges between -1 and 1. A high NBR value indicates healthy
vegetation. A low value indicates bare ground and recently burnt
areas. Non-burnt areas usually have values close to zero.

dNBR values can vary from case to case, and so, if possible, interpretation
in specific instances should also be carried out through field assessment;
in order to obtain the best results. However, the United States Geological
Survey (USGS) proposed a classification table to interpret the burn
severity, which can be seen below in the table.

B (5] subset_3_of_S24_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856 _resampled - [not saved] - SNAP - a X
ile Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help ‘
A HE S S J P [ Aer Al ORI |# viviy
Product Explorer X l Pixel Info \ —_ ;ﬁ[sjd_NBR xi vyvO g
i-[# B8 (842.0 nm) 7 =
i B12(2190.0 nm) Bl e &
i@ doud_mask S i s
[ Ner (328 i Unburned 5
-7} dner Y A U i 3
Navigation..._li(:plggr... X EUncenaint..._World View ‘ = ; =
Editor: () Basic (@) Sliders () Table > Bl @
Logyg g
Name: d_NBR 2% B
Unit: i 2
Min: -6.456 S 5
Max: 1.313 =% 5
100%
oo
= =
A I 5
T, , .  Severity | :
4 el = X C—
Boo ﬁ 3 & R < @ > a &
7l [y
Y - Lat - Lon - Zoom -- Level - Pixel Spacing: --m --m @
Severity Level dNBR Range (scaled by 103) dNBR Range (not scaled)
[ Enhanced Regrowth, high (post-fire) -500 to -251 -0.500 to -0.251
Enhanced Regrowth, low (post-fire) -250to -101 -0.250to -0.101
0 unburned -100 to +99 -0.100 to +0.99
Low Severity +100 to +269 +0.100 to +0.269
Moderate-low Severity +270 to +439 +0.270 to +0.439
¥ Miderate-high Severity +440 to +659 +0.440 to +0.659
. High Severity +660 to +1300 +0.660 to +1.300
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Comparison: Severity map, NDVI and false color composition

To compare different views of the same area and explore it more in detail,
create also NDVI and false color composition. You can observe, that areas
with high NDVI values correspond to the barren areas affected by
wildfires. False color composition also depicts areas affected by fire — these
areas are shown in dark pixels. False color composite B8-B4-B3 of the
Sentinel 2 image (during fire), with superimposed ongoing wildfire sites,
note that the smoke direction is corresponding to the wind direction.

B (5] d_NBR - [subset_3_of S24_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856_resampled] - [not saved] - SNAP = O X
File Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help ‘Qv Search (Ctrl+I) |
B e ] = # ocp age SR
aP HE S A PIQ A UORMEY TRELSBEE N OE Aciviviy
Product Explorer X | PixelInfo | = \‘[4] NDVI XL‘ B e~color B s1dner X d &
[ 88 (842.0nm) YIRS e X giiﬂ-‘f{;. s R | TR B o SEU )
[ B12(2190.0 nm) S T & i | o
[ doud_mask S
[ NBrR “:?7

o[ _dNER £ &
‘ColourMa...luncenaim...‘World e X - -
@
=)

s
g
=
5 s
e, =<
=
=
&
a
=
5
a
[}

Off Globe ) Downloading

0

Zoom - Level —

THANK YOU FOR FOLLOWING THE EXERCISE!

@ cSa \,@‘f_‘l OSTAV GEOGRAFIE E%fggz?gga SAFARIKA




